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ABSTRACT:  While government design criteria commonly exist paper and web-page formats, few are expressed in 
a computable format.  Current design systems provide no way to directly interact with these criteria.  Facility Com-
poser is a suite of tools designed for use by facility planners, designers, and engineers during the initial phases of 
facility planning and design.  Facility Composer associates customer-specific, computable criteria with a growing 
facility model that continues throughout the life cycle of the facility.  In Facility Composer, criteria can be associ-
ated with different project elements based on the appropriate level of detail, from the project to the site, the building, 
story, function, and down to the individual space.  Facility Composer’s ability to maintain a linkage between criteria 
and project elements: (1) helps ensure that critical criteria are followed, (2) helps organize criteria and makes them 
available at their point of use, and (3) simplifies creation, maintenance, and distribution of new criteria.  This tutorial 
documents and illustrate the use of specific Planning Composer program features. 

DISCLAIMER:  The contents of this report are not to be used for advertising, publication, or promotional purposes.  
Citation of trade names does not constitute an official endorsement or approval of the use of such commercial products.  
All product names and trademarks cited are the property of their respective owners.  The findings of this report are not to be 
construed as an official Department of the Army position unless so designated by other authorized documents. 
DESTROY THIS REPORT WHEN IT IS NO LONGER NEEDED. DO NOT RETURN IT TO THE ORIGINATOR. 
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Conversion Factors 

Non-SI* units of measurement used in this report can be converted to SI units as 
follows: 

Multiply By To Obtain 
acres 4,046.873 square meters 

cubic feet 0.02831685 cubic meters 

cubic inches 0.00001638706 cubic meters 

degrees (angle) 0.01745329 radians 

degrees Fahrenheit  (5/9) x (°F – 32) degrees Celsius 

degrees Fahrenheit (5/9) x (°F – 32) + 273.15. kelvins 

feet 0.3048 meters 

gallons (U.S. liquid) 0.003785412 cubic meters 

horsepower (550 ft-lb force per second) 745.6999 watts 

inches 0.0254 meters 

kips per square foot 47.88026 kilopascals 

kips per square inch 6.894757 megapascals 

miles (U.S. statute) 1.609347 kilometers 

pounds (force) 4.448222 newtons 

pounds (force) per square inch 0.006894757 megapascals 

pounds (mass) 0.4535924 kilograms 

square feet 0.09290304 square meters 

square miles 2,589,998 square meters 

tons (force) 8,896.443 newtons 

tons (2,000 pounds, mass)  907.1847 kilograms 

yards 0.9144 meters 

 

                                                 
*Système International d’Unités (“International System of Measurement”), commonly known as the “metric system.” 
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1 Introduction 

Background 

Facility Composer is a suite of tools for use by facility planners, designers, and 
engineers during the initial phases of facility planning and design.  While origi-
nally developed to support the design of government facilities, Facility Composer 
is based on the general concepts of:  (1) providing a method to effectively and 
creatively create and use criteria libraries, (2) providing support for architectural 
programming and project specific criteria specification during interactive design 
charrettes or at the designer’s desktop, and (3) supporting the creative and ana-
lytical aspects of architectural conceptual design involving the creation of one or 
many solutions from the specified criteria in an intuitive design environment. 

While not enforcing any particular design process, Facility Composer is designed 
to be able to support the process flow shown in Figure 1.   

 
Figure 1.  Facility Composer data flow. 
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The most important concept of Facility Composer is the program associates cus-
tomer-specific and computable criteria with a growing facility model that 
continues throughout the life cycle of the facility.  While many volumes of gov-
ernment design criteria exist in the form of design guides, regulations, technical 
manuals, and web pages, few, if any, of these are expressed in a computable for-
mat.  In addition, current design systems do not provide a way to directly inter-
act with these criteria, nor do they provide an efficient way to extend the func-
tionality of an application to directly support criteria usage.  With the evolution 
of facility modeling standards, these restrictions will be overcome by emerging 
design systems.  

In Facility Composer, criteria can be associated with different project elements 
based on the appropriate level of detail, from the project to the site, the build-
ing, story, function, down to the individual space.  For example, Facility 
Composer allows one to specify that a target schedule and cost be associated with 
a project, that masonry exterior walls and a steel structure be used on a build-
ing, that 32-Watt T-8 florescent lights be used in corridors and 50 foot-candles be 
maintained in the offices, and that a particular room will have VCT flooring.  
Facility Composer’s ability to maintain a linkage between criteria and project 
elements (site, building, story, etc.) provides many benefits: 
• It helps ensure that critical criteria are followed, and that desired character-

istics are recorded and addressed. 
• It helps organize criteria and makes it available at its point of use.  It helps 

in defining criteria and can help in recording its rationale. 
• It simplifies creation, maintenance, and distribution of new criteria.  For ex-

ample, as requirements that better implement sustainable design principles 
are developed, these are added to an organization’s standard library for use 
in subsequent projects.   These libraries are typically organized around facil-
ity type, but are not required to be. 

It helps support rapid conceptual and detailed design & analysis (cost, struc-
tural, HVAC, energy, electrical, O&M, etc.) either directly or through standards, 
such as the International Alliance for Interoperability’s Industry Foundation 
Classes (IAI-IFC) and Building Lifecycle Interoperable Software (BLIS). 

Owners with numerous facility holdings, in particular, reap benefits from this 
approach as it helps ensure the initial design satisfies their corporate criteria, 
shortening the review process and avoiding “design by review.”  All of these 
benefits result in cost and time savings by reducing the number of user changes 
made late in the design process or during construction.  Design quality is also 
enhanced, as many alternatives can be explored rapidly. 

http://iaiweb.lbl.gov/
http://iaiweb.lbl.gov/
http://cic.vtt.fi/projects/blis/


ERDC/CERL SR-04-30 3 

 

The primary tools in the Facility Composer application suite include: 
• Requirements Composer, a web-based application that helps in the devel-

opment of corporate and building specific criteria libraries 
• Planning Composer, which helps users create an architectural program 

and to set values for project specific criteria 
• Layout Composer, provides an environment for the designer/user to rapidly 

create 2D and 3D conceptual facility designs solutions 
• Wizards that provide support for various discipline specific issues and assist 

in the completion of individual design tasks and calculations. 

Objective 

This objectives of this work was to document and illustrate the use of the Plan-
ning Composer program.  

Approach 

Principle functions of the Planning Composer program were reviewed, and steps 
for each function were outlined and illustrated.   

Scope 

This work focuses on examples and discussions illustrating use of Planning 
Composer.  This work assumes that the user has already acquired and installed 
the Planning Composer software.  Installation procedures may be found in the 
Planning Composer User’s Guide, Chapter 3. 

Mode of Technology Transfer 

This work supports the implementation and use of Planning Composer, which is 
being developed as part of the Totally Integrated Project Delivery (TIPD) pro-
gram.  This report will be made accessible through the World Wide Web (WWW) 
at URL: 

http://www.cecer.army.mil 

http://www.cecer.army.mil/
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2 Planning Composer Tutorial 
Planning Composer is used to develop a facility “architectural” program and to 
add and set project specific criteria.  This includes traditional information such 
as the total project area and allocation of area to specific architectural functions 
such as circulation and offices.  It also contains discipline-specific criteria such as 
requirements for structural, electrical, HVAC, lighting, and plumbing.  The level 
of detail in the architectural program varies from project to project, and can be 
specified as such in the system. 

With just a few parameters set, the information in Planning Composer is suffi-
cient to prepare a preliminary cost estimate and schedule.  For example, it is ac-
ceptable to create a project that contains a list of architectural functions and 
their allocated areas without deciding how many buildings will be required.  On 
the other hand, the planner may create a project with detailed information such 
as the number of buildings and the number of stories in each building.  Obvi-
ously, the latter cost estimate will be more accurate.  Typically, the planner will 
not create such a detailed program from scratch, but will copy it from a similar 
project and tailor it to suit the current customer’s needs.  Users benefit from 
Planning Composer not only because it provides a method to capture, use, and 
reuse this explicit criteria, but also because it can often assist designers by pro-
viding a deeper understanding of the rationale behind certain decisions, from 
which other, better, solutions could be considered. 

Creating a New Project in Planning Composer 

This chapter presents some practice exercises that demonstrate some of the key 
features of Planning Composer and also some possible approaches to using Plan-
ning Composer at different stages of the planning process. 

Start Planning Composer by clicking on the desktop startup icon:    

Result:  The Main Planning Composer screen appears (Figure 2).  The 
screen is currently blank. 
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Figure 2.  Main Planning Composer screen. 

At this point, you may open an existing project if you have one, or you may cre-
ate a new project, as we will do in this exercise. 

From the File menu, choose New, and then Project. 

Result:  The New Project dialog box opens (Figure 3). 

 

 
Figure 3.  New Project dialog box. 

Enter a meaningful file name for the new project and click the  button.  
(The name you choose will be assigned to the project file.  A directory will also be 
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created using this name to hold the project data.)  This example will call the new 
project, Project1. 

Setting the Default Library 

The new project may take a moment or two to load, after which the Facility 
Requirements Selection dialog box will appear (Figure 4). 

 
Figure 4.  Facility Requirements Selection dialog box. 

Here you will select the Facility Library for use with this project.  At your site, 
you may have access to a number of libraries containing object criteria and func-
tion templates.  The dropdown menu will display your options.  If you have saved 
libraries, that do not appear in the dropdown bar, click the  button next to the 
dropdown bar to manually browse for your library. Once you have chosen a de-
fault or baseline facility library and committed by clicking the OK button, this 
library is permanently linked to your project and may not be changed at a later 
time, although additional libraries may be added over the course of the project by 
adding Components.  If you need to access a different base library at some future 
date, you will need to create a new project. 

The bottom portion of the Facility Requirements Selection dialog box dis-
plays the Library Information.  Select a library in the top portion of the screen 
and view the information about this library here.  Make special note of the Units 
field.  This field specifies the unit of measure used for the criteria/requirements 
in this library.  If the unit is set to Metric, then all linear measurements will be 
in millimeters and all area measurements will be in square meters; if the unit is 
English, then all linear measurements will be in feet and all area measurements 
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will be in square feet.  This is an important consideration and may not be 
changed later, so choose a library whose units are appropriate for your project. 

For this exercise, choose General – English.  The standard unit for our project will 
be English units.  Click the  button to complete the selection. 

As stated previously, once the Facility Library has been set for the project, it 
cannot be changed. 

Result:  The main screen opens again (Figure 5).  This time the Project 
and Site are displayed in the Project Composition panel.  The name of 
the open project file appears across the top of the window, along with the 
base Unit and the Alternative name.  (Alternatives will be discussed later 
in the manual.) 

 
Figure 5.  Main Planning Composer screen after opening a new project. 

Assigning Project and Site Codes 

With the Project level highlighted in the Project Composition panel, click the 
Properties tab in the Requirements panel.  Enter a project Display Name 
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(this sample uses CONF CENTER) and a descriptive Name for the project such 
as MIDWEST CONFERENCE & TRAINING CENTER.  At the project level, you 
have the opportunity to provide some other project information.  You may enter 
values for Project Number, Fiscal Year, Prepared Date, and Prepared By.  
The Unit field is already populated based on the library that you had previously 
chosen.  Press the <ENTER> key to update the Project Composition tree. 

In the Project Composition tree in the left portion of the screen, click the Site 
object.  (Bear in mind that the right panel of the screen, Requirements, is di-
rectly linked to the current (or selected) object in the Project Composition tree 
or left panel of the screen.  If Site is chosen, then the Requirements panel dis-
plays information specific to the site.  If the Project is chosen, then the Re-
quirements panel displays information that applies to the entire project.) 

Click the Properties tab in the Requirements panel.  Here is where you spec-
ify the basic site properties. 

In the Display Name field, type a short code or label for this project.  This ex-
ample uses the display name, CHAMPAIGN.  If you wish, use the Name field to 
enter a longer descriptive project name.  At the site level you may also enter val-
ues for City, State, and Zip Code.  Press the <ENTER> key when you have fin-
ished. 

Result:  The Project Composition tree is updated to display the site 
name (Figure 6). 

 
Figure 6.  Project composition tree showing updated site name. 

Adding Function Templates to a Site 

At the early conceptual stage of the planning process, the planner will begin to 
think about the functional requirements for the project.  Planning Composer 
can streamline this process. 
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The library that we chose when the project was created contains a list of function 
templates that will be used as the preliminary building blocks in designing this 
concept and coming up with a very basic cost estimate for the center.  Assume 
that this Conference Center contains the facilities, such as a parking lot, a main 
building with a large conference center and a building to house training facili-
ties.  Assume also that budget constraints will limit the final square footage for 
this center to approximately 50,000 sq ft of indoor space on a site of approxi-
mately 80,000 sq ft. 

Begin by selecting Site CHAMPAIGN in the Project Composition tree. 

Make sure that the Program tab is selected in the Project Requirements 
panel.  The Program tab contains information related to the architectural pro-
gram for the current object.  Notice the Planning View/Placing View radio 
buttons on the bottom of this tab.  For this tutorial, we will be using only the 
Planning View.  The Placing View is used for projects for which space layout 
operations have already been performed.  This function is used within Layout 
Composer (See Layout Composer User’s Manual for more information).  Click the 

 button next to the Function Templates grid (Figure 7). 

 
Figure 7.  Import button for adding functions. 

Result:  The Add Function Template dialog box appears (Figure 8). 
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Figure 8.  Add Function Template Dialog Box. 

The left window displays the list of function templates that are contained in the 
Library.  Click on one of the templates to select it.  Note that the panel on the 
bottom of the screen changes.  Click on the tabs to display the crite-
ria/requirements that come “pre-loaded” with this template.  The Properties 
tab displays the basic descriptors for the chosen template.  The Discipline tabs 
(Architecture, Electrical, etc.) contain criteria/requirements specific to that par-
ticular discipline.  The first six discipline tabs shown in Figure 8.  (Architecture, 
Arch/Int Design, Electrical, Fire, Mechanical & Security) are standard and will 
be present for most templates.  However, some function templates may include 
additional discipline tabs beyond the standard six.  The template chosen in Fig-
ure 8  contains an additional tab called “Civil.” 

Begin adding templates to our site by selecting a function template for the park-
ing lot.  Use the scroll bars, arrow keys, and/or PgUp/PgDn keys to locate 
PARKING LOT in the template list, then click on it to select it.  You may click the 
properties or discipline tabs to browse the criteria/requirements that have al-
ready been preloaded into this template.  Once your selection has been made in 
the left panel, click on the  button (or simply double-click the function tem-
plate name in the left panel).  The selected template name will copied to the 
right panel to indicate that it is ready to be added to the project.  You may also 
add additional templates to this site, such as BASKETBALL COURT or 
RETENTION POND.  



ERDC/CERL SR-04-30 11 

 

Click the  button to add all the function templates listed in the right 
panel of the dialog box to the site.  At this point, the Site Program grid on the 
main screen will have been updated to include the added templates (Figure 9). 

 
Figure 9.  Site program with added architectural templates. 

Assign a planned square footage for the parking lot function by double-clicking 
in the Site column in the Parking lot row of the grid, backspacing to clear the 
field, and then typing in a value of 20000.  (If you need to widen a column to see 
the entire column entry or label, then position your mouse cursor over the verti-
cal bar between columns until the arrow appears.  Hold down the left mouse but-
ton and slide the bar to the desired width.)  Notice that the right three columns 
(Site, Available & Allocated) refer to the space usage for the site level, while the 
left three columns (Project, Available & Allocated) refer to the space usage for 
the project level.  

Now select Project CONF CENTER in the Project Composition Tree.  No-
tice that the Project Program grid displays (Figure 10). 

 
Figure 10.  Project Program Showing Roll-Up from Site Program. 
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The new grid illustrates two key points.  First, you will see that adding a func-
tion template at the site level automatically adds the template at the project 
level.  The Project level is the top node of the Project Composition tree and 
will therefore display a roll-up of all function templates at all nodes beneath it.  
Secondly, notice that the “-20000” appears in red in the Available column.  This 
reminds us that we are currently under-planned and that we need to “Plan” the 
20,000 sq ft for the parking lot at the Project level.   

Double-click in the Project column of the grid, backspace to clear the field and 
enter a value of 20000.  Press the <ENTER> key or click in a different cell.  The 
Available field changes to 0. 

Adding Function Templates to a Project 

At this point, we are ready to add other function templates at the Project level. 

With the project selected as the current object in the Project Composition tree, 
choose the Program tab.  Click the  button next to the Architectural 
Function Templates grid 

Use the Add Function Template dialog box to select these function templates 
and any others that you wish to include: 
• ASSEMBLY HALL 
• CLASSROOM 
• COMMUNICATION CENTER 
• CONFERENCE 
• CORRIDOR  
• ELECTRICAL ROOM 
• LIBRARY 
• OFFICE PRIVATE 
• OFFICE SHARED. 

Click the  button to choose each template, then once all selections are com-
pleted, click the  button. 

Note:  We have added two different templates for office space.  This dem-
onstrates the fact that templates for functions in the same general cate-
gory (such as office space) may vary widely and represent a totally differ-
ent set of criteria/requirements.  Check the criteria/requirements 
carefully to find the best fit for your project. 
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Adding Planned Areas to a Project Architectural Program 

At this planning stage, you may want to assign some general space requirements 
to the architectural program for your project.  You may have some general con-
cept of how large the total project will be based on budget constraints, project 
specifications or occupancy requirements.  If you do have some reliable esti-
mates, this is the time to enter them into the Planned columns for these tem-
plates.  This example uses the estimates shown in Figure 11. 

 
Figure 11.  Adding planned areas to a project program. 

After typing in each value, press the <ENTER> key.  Notice that the Planned 
field in the Project Area portion of the screen reflects the total area that has 
been planned so far in all of the functional areas (Figure 12).  (The Actual Area 
will remain at 0 until you place space objects.  Placing space objects will be per-
formed in Layout Composer.) 

 
Figure 12.  Project area showing total planned area and total actual area. 

We could close Project1 at this point having achieved a good first cut of our pro-
ject program.  Though the areas do not represent actual spaces at this time, a 
rough cost estimate could be generated based on our total area and general func-
tional breakdown.  We can also expand on Project1, add some layers of detail, 
and take the plan to the next level of detail. 

Adding a Building to a Project 

From the File menu, choose the Save as Project menu option.  In the Save as 
Project dialog box, type Project2 into the File Name field and then click the 
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 button.  This accomplishes several things, it:  (1) saves our first project 
(Project1), (2) makes a copy of Project1, (3) names the copy Project2, and 
(4) opens it for editing.  Creating an Alternative to the Project can also do this.  
Planning Composer allows the user to store multiple alternate plans or options 
all within the same base project.  Alternatives will be explained later in this 
manual.  

While Project1 is a bare bones plan consisting of two objects: a Project and a 
Site, Project2 will include the next obvious addition to any respectable architec-
tural plan:  Buildings. 

In the Project Composition tree, select the Project.  Right mouse click to 
bring up a pop-up menu of actions that can be performed at the project level.  
From the menu, choose Add Building.  (This same task can be accomplished by 
choosing Add Building from the Building menu at the top of the screen.)  

Result:  A Building appears in the Project Composition tree (Figure 13).  

 
Figure 13.  Project composition tree. 

Select the Building in the Project Composition tree.  It is now the current 
object. 

Click the Properties tab in the Project Requirements panel.  Enter values 
into the fields as shown in Figure 14. 

 
Figure 14.  Building properties tab. 

Repeat the previous two steps above to add a second building.  Give this one a 
display name of TRAINING. 

Result:  Figure 15 shows the resultant Project Composition tree. 
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Figure 15.  Project Composition tree. 

Note that the name you enter in the Display Name field displays in the project 
composition tree. 

Adding Function Templates to a Building 

Select the Project in the Project Composition tree.  Select the Program tab 
in the Project Requirements panel. 

A quick way to add a function template to a building instead of using the Import 
Button is by using the Drag and Drop method.  Select the template in the Pro-
ject Program grid, then holding down the left mouse button, drag and drop it 
onto the Building in the Project Composition tree. 

To Building CONFERENCE, drag and drop these templates: 
• ASSEMBLY HALL 
• COMMUNICATION CENTER 
• CONFERENCE 
• CORRIDOR  
• ELECTRICAL ROOM 
• OFFICE PRIVATE 
• OFFICE SHARED. 

To Building TRAINING, drag and drop these templates: 
• CLASSROOM 
• COMMUNICATION CENTER 
• CONFERENCE 
• CORRIDOR  
• ELECTRICAL ROOM 
• LIBRARY. 

Select each building in the Project Composition tree.  Verify that the tem-
plates have now been copied to the Building Program for each of the buildings. 
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Select Building TRAINING.  In the Building column for the “Communication 
Center” template, enter a planned area of 500 (Figure 16). 

 
Figure 16.  Building program showing planned area for an architectural template. 

Immediately we know that 500 sq ft (out of the 1000 planned for the project) re-
main in the Project Available column for placing elsewhere in the project. 

Select Building CONFERENCE.  In the Building column for the “Communi-
cation Center” template, enter the remaining 500 sq ft. 

Creating an Alternative to a Project 

Next, we will want to plan the usage of the Training Building in our project.  Let 
us keep our options open at this point and experiment a little.  One feasible plan 
may include a one-story building attached by a covered walkway to the Confer-
ence Building.  An alternate plan might include a multi-story Training building.  
Planning Composer allows the user to store multiple alternate plans or options 
within the same project.  These options are called Alternatives.  Each new al-
ternative is based on the Base plan.  The Base Alternative is the name given 
to the initial alternative at project startup/creation.  We will let our current plan 
be the base alternative and then branch off into a couple of different directions 
from here. 

From the File menu, choose Create Alternative. 

Result:  The Create Alternative dialog box opens (Figure 17). 

 
Figure 17.  Create alternative dialog box. 
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The alternative is given a default Name of Alternative_1, but you may change it 
if you wish by typing in the name of your choice.  In the Desc field, add a de-
scription that will distinguish this plan from any other alternatives.  Click the 

 button to continue. 

Result:  A confirmation box informs us the alternative was created (Fig-
ure 18). 

 
Figure 18.  Create alternative dialog. 

Next, choose Open Alternative from the File menu. 

Result:  The Open Alternative dialog box opens (Figure 19). 

 
Figure 19.  Open alternative dialog box. 

Click the arrow on the dropdown menu in the Name field.  Note that the choices 
are Alternative_1 (the alternative just created) and the Base Project.  Choose 
Alternative_1, then click the  button. 

Adding a Story to a Building 

Select Building TRAINING in the Project Composition tree, then right 
mouse click to reveal the pop-up menu.  Choose Add Story.  (Alternatively, se-
lect Building TRAINING, then select Add Story from the Story menu at the 
top of the screen.) 

Notice that a  appears in the Project Composition tree next to the Build-
ing TRAINING object.  The  indicates that the tree may be expanded at this 
point to reveal the next level.  Click the  to expand the tree. 
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Result:  A Story appears in the tree (Figure 20).  It occupies the position 
one level below Building TRAINING. 

 
Figure 20.  Project composition tree with a story. 

Repeat the step above to add an additional story to Building TRAINING. 

Select the first Story object.  Click the Properties tab and enter a Display 
Name of T1.  In the Name field, enter a description such as Training Center - 
Ground Floor.  Leave the Elevation value at 0 for now. 

Select the second Story object.  Click the Properties tab.  This time enter T2 
into the Display Name field.  Enter Training Center - Second Floor into the 
Name field.  Again, leave the Elevation set to 0. 

From the View menu, choose Refresh.  Click the  next to Building 
TRAINING.  Note that the stories may not be listed by the story Display Name 
or Name as you might expect.  The stories are ordered in the Project Composi-
tion tree by the elevation values. 

Select Story T1.  On the Properties tab, set the Elevation to 0 feet (since this 
is the ground floor) and on the Architecture tab set the Floor-to-Floor-
Height to 14 feet. 

Select Story T2.  On the Properties tab, set the Elevation to 13.33 feet and on 
the Architecture tab set the Floor-to-Floor-Height to 14 feet. 

Refresh the tree again.  This time the stories appear in proper order.  The Re-
fresh View feature is useful for displaying changes made to objects on the tree. 

Now add a single story to Building CONFERENCE.  Give it a Display Name 
of C1 and an appropriate Name, Elevation, and Height (Figure 21). 
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Note:  The Project Composition 
tree has gained some new branches.  
Notice the hierarchical relationship 
between the Project, Site, Build-
ing and Story objects. 

Adding Function Templates to a Story 

Use the same Drag and Drop method used to 
copy function templates from the Project level to the Building level to copy 
function templates from the Building level to the Story level. 

Select Building CONFERENCE.  Click the Program tab.  Drag and drop ALL 
the function templates to Story C1 from Building CONFERENCE. 

Hint:  A quick way to select all the function templates is to select the 
first template, then while holding down the <SHIFT> key, select the last 
template. 

Select Building TRAINING.  Click the Program tab.  Drag and drop ALL the 
function templates from Building TRAINING to Story T1. 

An alternate method for adding function templates to a story is to select Story 
T1 under Building TRAINING,  then click the Program tab.  Click the 

 button next to the Architectural Function Templates grid.  This 
opens the Add Function Template dialog box.  Locate and double-click the 
function template called AUDIOVISUAL STORAGE.  Click the  button to 
complete the addition. 

Note:  Since the AUDIOVISUAL STORAGE template had not previously 
been added to Building TRAINING, it would be added to the building 
level at this point.  Adding a template to a “lower” node of the project hi-
erarchical structure automatically adds it to the higher nodes.  In other 
words, adding a template at the Story Program level, also adds that 
template to the Building Program and Project Program.  This is be-
cause the Building Program includes a roll-up of all of the Story Pro-
grams for that building.  The Project Program includes a roll-up of all 
architectural programs in the entire project. 

 

 
Figure 21.  Single story added to 
Building CONFERENCE. 
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Adding Project Specific Criteria/Requirements to an Object 

We may add custom design criteria/requirements to any object in the Project 
Composition tree.  Suppose that we need to stipulate some special outdoor 
lighting criteria/requirements for the Training Center entrance.  These crite-
ria/requirements will be specific to Building TRAINING.  These crite-
ria/requirements will not be copied to the template library. 

Select the Building TRAINING.  Seven pre-defined tabs are labeled in the Pro-
ject Requirements panel: Architectural, Electrical, Fire, Mechanical, Struc-
tural, Civil, & Security.  These tabs are used to store criteria/requirements in 
any of these different disciplines or categories.  Depending on the library that 
you loaded at project creation, you may have inherited some building-specific cri-
teria/requirements.  You may click the discipline tabs to browse this data if it 
exists. 

Click the Electrical tab.  If there were no lighting requirements loaded for this 
building at project creation time, the notation “No Requirements Defined” will be 
displayed on the Lighting tab for this site. 

Click the  button. 

Result:  The Add Project Requirements dialog box opens (Figure 22). 

 
Figure 22.  Add project requirements dialog box. 

Choose Electrical from the dropdown menu for Discipline Name.  Decide on a 
name for this Category. Enter a descriptive Name for the Requirement.  
Since this requirement requires a numerical parameter, we will choose the 
Whole Number data type radio button.   
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There are four data types to choose from.  The data type choices include: (1) Text 
for textual data such as “Incandescent,” (2) Decimal for numerical values that 
will include decimal places such as “0.00056,” (3) Whole Number for numerical 
values without decimal places such as “100” or “-50” and (4) True/False where 
the only allowed values are either “True” or “False.”  Enter the criteria Value (in 
this case 250) and enter the UOM (unit of measure) in which the value is re-
corded.  (We used WATTS.)  The Source field can be used to designate the source 
or regulation that has initiated this requirement.  The Comment field provides 
a place to document any additional information about the requirement.   

Click the  button when field entry is complete. 

Since we will not be adding any more Project Requirements at this point, click 
the  button to return to the Electrical tab. 

Result:  The criteria that we added appears in the Electrical Tab crite-
ria grid (Figure 23). 

 
Figure 23.  Project requirements panel showing added requirement. 

Note:  It is worth noting some special properties of the criteria grid.  
These properties are true for criteria that the user adds as well as for cri-
teria that come from a library.  The criteria grid displays the Category 
name in red.  Values that appear in black are editable. Generally speak-
ing for criteria that comes from the startup library, the Value column 
and Comment column are editable, while the UOM and Source col-
umns are not.  A non-editable field appears in gray on the grid.  The 
Comment field provides a place for the user to add any additional infor-
mation about the requirement.  It is especially useful for annotating the 
reason when a user decides to over-ride the default value from a library 
with a project-specific value. 
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Adding a New Discipline tab 

In addition to the outdoor lighting, perhaps we need to provide some code infor-
mation regarding the required street setback for the building.  This requirement 
does not clearly fall into any of the existing discipline tabs.  It would be handy to 
add a new discipline called:  Code. 

Select the Building TRAINING once again. 

Select any of the Discipline tabs in the Project Requirement panel. 

Click the  button. 

This time, instead of choosing any of the existing tabs from the Tab Name drop-
down menu, type Code into the Discipline Name field (Figure 24). 

 
Figure 24.  Add project requirement dialog box showing addition of a new discipline tab. 

Enter Building Setback into the Category field and Street Setback into the Name 
field for this requirement.  Click the Decimal Number data type radio button, en-
ter 0.0 into the Value field and enter ft into the UOM field.  You may also add a 
Source and Comment if you wish.  

Click the  button and then the  button and the new Discipline Tab 
will appear.  Click on the new Code tab. 

Result:  The Project Requirements panel contains a tab labeled Code 
containing the new requirement (Figure 25). 
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Figure 25.  Project requirements panel showing new discipline tab and requirement. 

Adding a Function to a Story 

So far we have talked about function templates.  We know that they come from a 
library.  We know they represent a set of criteria associated with a specific func-
tion or need that the project must address.  We know that they can be added to 
Facility Composer objects, namely Projects, Sites, Buildings, and Stories for 
general planning purposes.  The template is used to create the next object in our 
Project hierarchical structure:  Functions.   

You are probably familiar with the concept of a template.  You may have used a 
drawing template for a drafting project or a word processing template to create a 
document.  The template supplies the pattern or starting point for creating an 
object.  In general, you supply the substance to make the object unique and use-
ful to you.  In this case, the function that you add to your building project will be 
customized to the specific needs of your client.  Though the template provides a 
rough cut, the Function Instance provides a precise fit for your project. 

Select Story T1 in Building TRAINING.  Right-mouse click to display the pop-
up menu.  Select Add Function. (Alternatively, Select Add Function from the 
Function menu at the top of the screen.) 

Result:  The Add Function Instance dialog box opens (Figure 26). 
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Figure 26.   “Add function” instance dialog box. 

Note that all the function templates that have been added to this story appear in 
the list.  We would like to add a function to the story for all of these templates.  
To select all, you can either hold down the <CTRL > key and select each of the 
templates or select the first one, hold down the <SHIFT> key and select the last 
one.  Then click the  button.  Also note that by clicking the  but-
ton you can return to the Add Function Template dialog box and add templates 
that you had not added previously. 

Click the  that now appears next to the 
Story T1 object.  The Project Composition 
tree expands to reveal the new functions (Fig-
ure 27). (If you cannot see the entire function 
name in the Project Composition panel, 
then drag to the right the bar located between 
the Project Composition panel and Project 
Requirements panel.  Or, slide to the right 
the scroll bar on the bottom of the Project 
Composition panel.) 

Next, Select Story T2 for Building TRAINING.  Notice that we have added no 
templates to Story T2 yet.  Right-click on Story T2 and choose Add Function 
from the pop-up menu.  Once again, the Add Template Instance dialog ap-
pears.  You will notice that the templates that have been added at the Building 
level appear in the dialog box.  When no templates exist at the Story level, 
Planning Composer looks for templates at the next higher (or Building) level.  
Select CLASSROOM, CONFERENCE, CORRIDOR, OFFICE PRIVATE, and 
OFFICE SHARED.  (Hold down the <CTRL> key and select each one.) Then click 

 
Figure 27.  New functions in Project 
Composition tree.. 
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the  button to create Story T2 functions based on these five templates.  
Click the  next to Story T2 in the Project Composition tree to display the 
five new Function objects. 

Changing Function Attributes 

Select the Function OFFICE PRIVATE on Story T2.  Click the Properties tab 
(Figure 28). 

 
Figure 28.  Properties tab for an architectural template showing renamed template. 

On this tab, you see the name of the template on which this function was based 
and the name of this function.  Currently, the function name is the same as the 
template name.  Change the function name to OFFICE PRIVATE – SUPERVISOR.  
Press the <ENTER> key. 

Choose the Electrical tab.  Hopefully, lighting requirements will already exist 
for this function and look something those shown in Figure 29.  If this is not the 
case, then follow the steps for Adding Project Specific Crite-
ria/Requirements and add the requirement Illuminance Required. 
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Figure 29.  Project requirements panel showing function attribute to be changed. 

Change the Illuminance Required value from 0.0 to 30.0. 

Select Function OFFICE PRIVATE under Story T1.  On the Properties tab, 
enter OFFICE PRIVATE – SUPERVISOR into the Name field.  This will name 
this function the same as the Function OFFICE PRIVATE – SUPERVISOR 
function for Story T2.  We can do so ONLY because both of these functions are 
based on the same function template, namely “OFFICE PRIVATE.”  The advan-
tage of doing this is that we inherit the criteria that we previously entered for 
this function OFFICE PRIVATE – SUPERVISOR.  This illustrates an impor-
tant concept when dealing with functions:  Functions with the same name have 
the same criteria.  Click the Electrical tab to verify. 

Though these functions do not represent actual spaces at this time, they provide 
the groundwork for the next phase of Facility Composer, namely Layout 
Composer.  For the present time, you may do some general space planning by 
entering the Planned Areas into the Building Programs and Story Pro-
grams. 
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Adding Planned Areas to a Building Architectural Program 

Earlier, we planned space usage at the Project level.  A next logical step would 
be to breakdown our space planning further by assigning planned areas at the 
Building level, the Story level and to the Function level.  We will plan the 
Building level first.  However, there is no reason that you could not begin with 
the Story or Function levels if you wish.  The Planning Composer program is 
designed to be flexible so that space planning could be approached from the top-
down or from the bottom-up.  Either way, the user can arrive at the same final 
goal, which is to achieve a space allocation plan for a project. 

Recall that our project plan calls for approximately 65,150 sq ft with approxi-
mately 41,000 sq ft dedicated to buildings.  We have two buildings in our plan, a 
CONFERENCE building and TRAINING Building.  Assume that the list of 
functional templates that we have added is complete and comprehensive.  That 
said, we may begin to break down our space allocation.  Allow approximately 
21,000 sq ft for the Conference Center, approximately 20,000 for the Training 
Center (10,000 per story).  

Select Building CONFERENCE in the Project Composition tree.  Select the 
Program tab.  The Building Program grid will appear (Figure 30). 

Now enter preliminary values into the Building column for each of the various 
functions.  Note the relationships between the columns as you enter values.  The 
Planned Area total at the top of the Building Program panel (Figure 31) 
keeps you apprised of the planned total area for the current building.  The first 
three columns after the function name in each row display project level area val-
ues.  The Available column in this block is useful because it displays the area 
that is still available to be planned at the project level.  If this value is negative 
or displayed in red, the area has been over-planned at the project level.   

 
Figure 30.  Sample building program for building CONFERENCE. 
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Figure 31.  Sample building program for building TRAINING. 

Adding Planned Areas to a Story Architectural Program 

A next step, if you choose, is to assign Planned Areas at the Story level.  For 
Building TRAINING in our example (Figure 32), you may enter Planned 
Area values for Story T1 and Story T2.  Total Planned area for both stories 
combined should be close to the total planned area for the building that we pre-
viously estimated at 20,000 sq ft. 

Enter Planned Area values for each story until you achieve the desired break-
down.   

 
Figure 32.  Sample story program for Story T1, building TRAINING. 

Adding Planned Areas to a Function Architectural Program 

A final step is to plan area at the Function level.  The Area Desired dialog box 
provides the user a great deal of flexibility in entering planned areas at this 
level. 
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Select Function Office Shared on Story T1. 

Result:  The Function Program grid should look like the grid displayed 
in Figure 33. 

 
Figure 33.  Function program grid. 

Click the mouse over the “0.0” in the Function column in the grid. 

Result:  The Area Desired dialog box opens (Figure 34). 

 
Figure 34.  Area desired dialog box. 

Click on the arrow in the Target (=)dropdown list box (Figure 35) and observe 
the choices for entering planned area. 

 
Figure 35.  Choices for added planned area at the function level. 
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For Function Office Shared, we will choose the Area/Person (x * occu-
pancy) option, because we want to base our planned area on office occupancy 
(Figure 36). 

 
Figure 36.   “Area desired” dialog box – “occupancy per person” option. 

Enter 100 into the Area Per Person field.  Enter 5 into the Occupant Load 
field.  Then click the  button.  Notice that the Function planned area in 
the Function Program grid changes to 500 sq ft. 

Generating a Report 

Three types of reports can be generated at this time.  This exercise will go 
through the steps of generating a Programmed Area Report.  Chapter 3 of the 
Planning Composer User’s Guide describes how to generate a Function Usage or 
Full Project Listing report. 

Programmed Area Report 

From the File menu, choose Report, and then Programmed Area Report. 

Result:  Programmed Area Report Dialog box appears (Figure 37). 
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Figure 37.  Programmed area report. 

Next, Click the Print button at the top of the dialog and select a location to save 
the report.   

Note:  Make sure when you name the file to “Save As” that you also enter 
the extension *.pdf  You will need a copy of Adobe Acrobat Reader to view 
this document. 
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3 Conclusion 
In Facility Composer, criteria can be associated with different project elements 
based on the appropriate level of detail, from the project to the site, the building, 
story, function, down to the individual space.  Owners with numerous facility 
holdings, in particular, reap benefits from this approach as it helps ensure the 
initial design satisfies their corporate criteria, shortening the review process and 
avoiding “design by review.”  All of these benefits result in cost and time savings 
by reducing the number of user changes made late in the design process or dur-
ing construction.  Design quality is also enhanced, as many alternatives can be 
explored rapidly. 

Planning Composer, one of the primary tools in the Facility Composer suite, 
helps users create an architectural program and to set values for project specific 
criteria.  This has documented and illustrated the use of the Planning Composer 
program.  
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Glossary 
Term Definition 

Actual Area 
(Placing View) 

(Compare to Planned Area) 
The area of the selected object as determined by Facility Composer; the pro-
gram calculates this value by totaling the areas of all spaces placed at this object 
level.   

Allocated Area 
(Planning View) 

The total area that has been allocated (assigned) to a function for a particular 
level of project hierarchy.  For example, the total area allocated to a particular 
function might be different for the story level, building level, and project level. 

Assigned Function 
(See Function) 
A function that was explicitly added to a program by the user. 

Attribute 
(Compare to Requirement) 
Physical characteristics of an object; for example, the name, height, and eleva-
tion of a story. 

Building 
An object in the Project Composition hierarchy.  A building object contains infor-
mation related to a single freestanding physical structure and can be further bro-
ken down by stories, functions, and spaces.  

Function A function can be related to other functions through three different means: 
1. A specialization relationship can exist where one function is the parent func-

tion and the other function is the child function, for example, the relationship 
between an office and private office.  A private office is a specialization of the 
office.  The office is the parent function and the private office is the child func-
tion. 

2. A spatial containment relationship can exist where one function physically 
contains another function, for example, the relationship between a lobby and 
the reception area.  sub-function. 

3. The final relationship is that of assigned and unassigned functions.  This type 
of relationship supports the “roll-up” capability through item programs. 

Function Template 
A Function definition from a library.  Templates are the parents of specific func-
tion instance objects added to project elements (site, story, etc.) 

Function Instance 
Function objects created from function templates and assigned to project ele-
ments.  All function instances created from the same function template aggre-
gate their areas for project planning purposes. 

Object 

An element (or node) in the Project Composition structure.  Since there is a hier-
archical relationship between all objects in this structure the structure is often 
referred to as a “tree.”  The PROJECT object occupies the highest level of the 
hierarchy.  From highest level to lowest level, the other objects include:  
BUILDING (and SITE), STORY, FUNCTION, and SPACE. 

Planned Area 

The total area for the selected project element, or for a specific function at a par-
ticular level in the project hierarchy (project, building, etc.) as determined and 
entered by the user.  This value expresses the estimated and desired area for 
this object.  In later stages of project development when spaces have been 
placed, the Actual Area value will be compared to the Planned Area value to de-
termine how closely the project layout is meeting the initial plan. 
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Term Definition 

Program 
A group of function templates added to a Project, Site, Building, or Story project 
element for planning purposes.  Planned areas are typically assigned during 
program development. 

Project A set of information pertaining to a building/construction project.  In Facility 
Composer, the project object occupies the highest level of the Project Composi-
tion tree.  All information for a Facility Composer project is stored in a PRJ file 
and directory that the user names on project creation.  In Facility Composer, only 
one project may be opened at a time. 
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